
Help project not selected
You may notice this prompt "No current Help project selected" when you attempt to compile a project. This 
message appears when an incorrect template is attached to the Help project file. 

RoboHELP comes with a specific template – ROBOHELP.DOT - that must be attached to Help project documents. 

To attach a template to a file: (Word 97 or higher)

1 Open a Help document.

2 From Word’s Tools menu, select Templates and Add-Ins…

3 Click Attach.

4 Select the ROBOHELP.DOT template.

5 Click Open.

6 Click OK.

To attach a template to a file: (Word 95)

1 Open a Help document.

2 From Word’s File menu, select Templates.

3 Click Attach.

4 Select the ROBOHELP.DOT template

5 Click Open.

6 Click OK.

Tips:

· You can use the pre-defined styles in the ROBOHELP.DOT template or customize the styles to suit your 
design needs. 

· If you change the styles in ROBOHELP.DOT, make sure to copy the styles from the template to each Help 
document to update the styles. (In Word, document styles override template styles.)



Document has no RoboHELP functionality
If a Help document has no RoboHELP functionality or loses that functionality, it generally means the wrong 
template is attached to the document. For RoboHELP to be recognized, the ROBOHELP.DOT template must be 
attached. Check the following:

· Did you do a SaveAs Word 97? If the document was a Word 95 document created in RoboHELP prior to 
version 5.0 and you saved it as Word 97, the document may have retained the old RoboHELP template 
(ROBORTF.DOT). Reattach the ROBOHELP.DOT template.

· Is Macro virus protection on? Check Word's Tools menu, Options, General tab. If you saved the document 
from an older version of Word to Word 97 and the Macro virus protection option is selected, Word may have 
attached the NORMAL.DOT template instead of ROBOHELP.DOT. Reattach ROBOHELP.DOT.

· Is Confirm conversion at open on? Check Word's Tools menu, Options, General tab. If the document is 
Word 95 or earlier, Word 97 may be automatically using the Confirm conversion at open option and converting 
the RTF file into a DOC file. WinHelp documents always use the RTF file to compile; without the RTF file, the 
document may lose communication with RoboHELP. Clear this option in Word, then reopen the Help project. 
You will be prompted to generate the RTF file. As long as you answer OK to this prompt, RoboHELP 
automatically generates the RTF and you should be able to work normally.



Macros convert when a Help document is opened
This problem usually means you have both Word 95 and Word 97 installed on your system. Windows chooses 
which version of Word to open based on what is listed in the Windows Explorer View menu, Options, File Types. 
You may need to edit the paths of the functions here – New, Open, and Edit – so they reflect the location of Word 
97, not Word 95.



Word 95 launches when Help document is edited
This problem usually means you have both Word 95 and Word 97 installed on your system. Windows chooses 
which version of Word to open based on what is listed in the Windows Explorer View menu, Options, File Types. 
You may need to edit the paths of the functions here – New, Open, and Edit – so they reflect the location of Word 
97, not Word 95.



System colors and window display don't appear correctly
This error occurs because WinHelp uses the user’s system colors in place of author-specified colors IF the system 
colors are other than black text on a white window. (Users can customize their system colors by selecting Settings 
from the Windows Start menu, selecting Control Panel, double-clicking on Display, selecting the Appearance 
tab, and then choosing either a Scheme or changing window colors.) 

There is no workaround to the way in which WinHelp reacts to this setting. 



Bullet characters are a strange font
If you’ve selected Maximum compression or if the Help system is viewed using Windows NT 4.0 or Windows 
2000, sometimes bullet characters from the Wingding font appear strangely. 

You can resolve this by trying one of the following options:

· Use a bullet symbol from the Symbol font.

· Select a different custom compression – don’t select Maximium, Zeck and Hall, or Hall compression. (Try Zeck 
or Phrase.)

· Use Microsoft's Character Map (from the Windows Start menu, Programs, Accessories, Character Map) to 
insert the symbol.



Bulleted or numbered lists don't indent properly
If you use Word's numbers/bullets buttons on the toolbar, the indent values are lost if you remove the 
numbers/bullets. If you then re-add them (or change, for example, from numbers to bullets) the indent values will 
be incorrect.

Use the styles list to define paragraph numbers or bullets.



Bullets or numbers appear with hotspot formatting
In bulleted or numbered lists, if the first word is part of a hotspot, a WinHelp compiler bug often causes the bullet 
or number to take on the hotspot formatting, too. To correct this, use RoboHELP's workaround:

1 From RoboHELP Explorer's Tools menu, select Options. The Options dialog appears.

2 Click the Compile tab.

3 Under RTF Output, select Remove Hotspot color from Bullets.

4 Click OK.

5 RoboHELP prompts you that for this change to be reflected in the compiled Help file, the documents in this 
project need to be saved as RTF.

· Click Yes to allow RoboHELP to open all documents in the project and save them as RTF.

· Click No if you want to save the affected documents yourself. (You won't see the change in the compiled 
Help file until you save the documents as RTF.) 

6 After the documents have been saved, compile the Help file.



Multi-level bulleted or numbered lists display incorrectly in ActiveTest
These types of lists will only display correctly after the Help system has been compiled (this is a Word limitation). 



Characters or typographic symbols don't appear correctly
If you're familiar with Microsoft Word, you know that you can usually add typographic symbols using the Insert 
Symbol command. However when developing Help systems, consider using the Character Map keystroke 
combination, as defined by the font in which you're operating.

· To find the keystroke combination for a typographic symbol, use the Character Map (Windows Start menu, 
Programs, Accessories, Character Map) to search for the desired symbol in the specified font. Make sure that 
you select the correct font before choosing the typographic symbol.



Bulleted or numbered list formatting copies to next paragraph
Word 97 automatically copies paragraph formatting if it thinks you're working with a list. This can be a very handy 
feature, but if you aren’t familiar with it you may get unexpected results. For example: If you have a line of text that 
starts with a hotspot, when you press Enter the next paragraph will start with the green hotspot text. 

Try one of the following options:

· Manually correct the list.

· Turn off Word's "helpful formatting" option: From Word's Tools menu, select AutoCorrect. Select the 
AutoFormat as you Type tab. Under Automatically as you type section, clear Format beginning of list item 
like the one before it. Click OK to save your changes. (You can also remove this option from the AutoFormat 
tab, too.)



Double quotation marks appear as a vertical bar
This results from using the MS Sans Serif font with the compression set to maximum. The typographical quotation 
mark (curly quote) appears as a vertical bar.

· Try using the Arial font instead of MS Sans Serif in Help files compiled with Maximum compression. It looks just 
about the same and eliminates the problem.



Numbered lists aren't numbered in the proper order
This error may be due to a bug in the Microsoft Windows 95 Help Compiler (it no longer supports auto-numbered 
lists). If you are using Word 97, it may be due to the new way Word 97 treats numbered lists; whenever you begin 
a new numbered list, Word 97 assumes it should continue the previous list. 

· You can try a RoboHELP fix. The Topic Text Numbered style that ships with RoboHELP seems to work in most 
instances. Try applying this style to your numbered lists and see if it gives you good results. If this does not 
work, use the Microsoft solution of hand-numbering all numbered lists.

· If the problem is due to the Word 97 numbering method, right-click next to the incorrect number and select 
Bullets and Numbering. Select the Numbered tab. In List Numbering, select Restart Numbering.



RoboHELP not loaded: Tool palette does not display
This usually occurs when the ROBOHELP.DOT template are not attached to the files.

· Make sure the ROBOHELP.DOT template is attached to the document:

To attach a template to a file: (Word 97)

1 Open a Help document.

2 From Word’s Tools menu, select Templates and Add-Ins…

3 Click Attach.

4 Select the ROBOHELP.DOT template.

5 Click Open.

6 Click OK.

To attach a template to a file: (Word 95)

1 Open a Help document.

2 From Word’s File menu, select Templates.

3 Click Attach.

4 Select the ROBOHELP.DOT template

5 Click Open.

6 Click OK.

Tips:

· You can use the pre-defined styles in the ROBOHELP.DOT template or customize the styles to suit your 
design needs. 

· If you change the styles in ROBOHELP.DOT, make sure to copy the styles from the template to each Help 
document to update the styles. (In Word, document styles override template styles.)



Popup topics display only titles
The problem occurs when the title of the topic contains a non-scrolling region. You can use any one of the 
following methods to resolve it:

· Remove the non-scrolling region from the topic. Highlight the entire topic, beginning with the page break and 
ending with the paragraph mark just before the next page break. From the Format menu, select Paragraph. For 
Word 97 or higher, click the Line and Page Breaks tab. For Word 95, click the Text Flow tab. Clear Keep with 
Next and click OK. Save the document and recompile the Help file.

· Use Microsoft word to create a new popup heading style that doesn't include the Keep with Next paragraph 
(non-scrolling region) attribute. Apply the new style to all existing popup topics. To automatically apply the popup 
topic heading style to new popup topics, customize your topic headings. From Word’s RoboHELP menu, select 
Advanced Settings. Click the Topic Headings tab. In Popup Topic, select a heading style that doesn’t contain 
a non-scrolling region (Keep with Next paragraph attribute). Click OK. All future popup topics you create will 
automatically use the heading style you’ve defined.



Images aren't displaying
If an image has been placed into your document with the Float Over Text attribute selected, you can only see the 
image when you display Word using the Page Layout View. These types of images will display in the compiled 
Help file. 

If you want to be able to see the image in Normal view, turn off the Float Over Text attribute:

1 Right-click on the image and select Format picture.

2 Click the Position tab. 

3 Clear Float over text.

If images aren’t displaying in the compiled Help file, make sure you’ve established at least one Image Folder in 
the Image Folders (BMROOT) section of the Help project. 

1 From RoboHELP Explorer's Images and Multimedia folder, open the Image Folders (BMROOT). 

2 If no image folders are listed, right-click on the Image Folders (BMROOT) folder and select New Image 
Folder. 

3 Enter the path to the image folder or navigate to it.

4 Compile the Help project.

5 If images still don’t display, check all the folders under Images and Multimedia to make sure all images are 
listed. If an image isn’t present, it displays with a red X through it. You can locate a missing image by right-
clicking on it and selecting Locate. Navigate to the appropriate folder and select Open.



F1/Shift+F1 does not work in Word
Close the Floating RoboHELP Palette toolbar, and then close Word. You can restart Word from RoboHELP 
Explorer’s Project tab, Topics folder by right-clicking on a Help document and selecting Edit. (Or you can click 

 from the Project Toolbar.)



Outlook prompts repeatedly for a password
If you have installed Outlook as your mail system in Office 97, it may prompt for a password when you launch or 
save in any application (including RoboHELP). You can restart your system to stop this from happening.



Unable to locate the library: ROBOHP32.DLL
This message usually appears when RoboHELP cannot locate the referenced DLL. This error usually occurs when 
RoboHELP is installed on a network and each user is not given the proper files.

· Often, simply reloading the software will take care of the problem. 



Word Basic Error 582: Unable to open specified library
This error message appears when Microsoft Word cannot find the RoboHELP templates. This may be due to one 
of the following scenarios. Follow the appropriate steps to correct the problem.

Microsoft Word cannot locate the necessary RoboHELP templates 

1 Open a document in Microsoft Word. 

2 From the Tools menu, click Options. 

3 Select the File Locations tab. 

4 Under File Types, select User Templates. 
The location of the templates folder should be the directory you specified when you installed RoboHELP. If the 
specified folder is incorrect, click Modify to navigate to the correct folder. Select the correct folder and click 
OK. 

5 Click Close and exit Microsoft Word. 

6 Start RoboHELP and re-open the file.

Some or all of the necessary RoboHELP templates are not installed 

If the User Templates folder location is correct and you receive this error message, if may be because not all of 
the correct RoboHELP templates are installed. The easiest way to combat this problem is to reinstall RoboHELP 
and make sure that you specify the correct template folder. 

There is more than one version of the RoboHELP templates installed on your system

If you have specified the correct template directory and checked to make sure that all necessary files are there 
and are still receiving this error message, you may not be using the proper templates for your particular version of 
RoboHELP and Word. Contact Technical Support to verify that you have the correct templates OR try reinstalling 
RoboHELP, making sure to select the correct version of Word.



Word Basic Error 1055: The document name or path is invalid directory
This error message appears when Microsoft Word cannot find the RoboHELP templates. This may be due to one 
of the following scenarios. Follow the appropriate steps to correct the problem.

Microsoft Word cannot locate the necessary RoboHELP templates.

1 Open a document in Microsoft Word. From the Tools menu, click Options.    Select the File Locations Open a 
document in Microsoft Word. 

2 From the Tools menu, click Options. 

3 Select the File Locations tab. 

4 Under File Types, select User Templates. 
The location of the templates folder should be the directory you specified when you installed RoboHELP. If the 
specified folder is incorrect, click Modify to navigate to the correct folder. Select the correct folder and click 
OK. 

5 Click Close and exit Microsoft Word. 

6 Start RoboHELP and re-open the file.

Some or all of the necessary RoboHELP templates are not installed. 

If the User Templates folder location is correct and you receive this error message, if may be because not all of 
the correct RoboHELP templates are installed. The easiest way to combat this problem is to reinstall RoboHELP 
and make sure that you specify the correct template folder. 

There is more than one version of the RoboHELP templates installed on your system. 

If you have specified the correct template directory and checked to make sure that all necessary files are there 
and are still receiving this error message, you may not be using the proper templates for your particular version of 
RoboHELP and Word. Contact Technical Support to verify that you have the correct templates OR try reinstalling 
RoboHELP, making sure to select the correct version of Word.



Lose communication between RoboHELP Explorer and Word
If your system seems to lose communication between RoboHELP Explorer and Word, one of the following could 
be causing the problem:

· Word 97’s AutoRecover option being turned on (Word's Tools menu, Options, Save tab). If this is the case, 
simply clear the AutoRecover option.

· This problem could also occur because the Microsoft Word Confirm conversion on open option is selected. 
Because RoboHELP works with RTF files as well as DOC files, if this option is turned on, Microsoft Word may 
automatically convert the RTF file into a DOC file; this means the RTF file no longer exists – and cancels the 
document’s RoboHELP functionality. If this is the case, clear the Confirm conversion on Open option (Tools, 
Options, General tab).

· A third reason this error can occur is when Microsoft Word is selected as your e-mail editor for Microsoft 
Exchange/Outlook. Simply turn off this option inside Exchange or Outlook.



WinHelp 3 project fails on compile
There are several reasons why a WinHelp 3 Help project might not compile:

· The Help project contains WinHelp 4 features and functionality. If the Help project’s Primary Target wasn’t set to 
WinHelp 3 or WinHelp 3 Compatible, RoboHELP wasn’t able to "turn off" WinHelp 4 functionality while you 
developed. Or if the Primary Target was changed at any time during development to either WinHelp 3 or 
WinHelp 3 Compatible, RoboHELP isn’t able to turn off or warn you of existing WinHelp 4 features and functions 
in the Help file.

· Long filenames or path names or spaces in filenames or path names. Check the filenames of your Help 
documents and the path names of your Help project, images, Map files, etc. If they are longer than 8 characters 
or contain spaces, rename the files or folders.

When you compile, check the Results dialog that appears at the end of the compile. If you receive the message 
that the project couldn’t compile, click Error Wizard to open the Error Wizard. Then click Explain to get an 
explanation of the error message and possible solutions to help you fix the error.



Unable to edit the CNT= setting in the HPJ file
If you need to edit the CNT= setting that appears in the HPJ file, open the HPJ file:

1 From RoboHELP Explorer's File menu, select Open File From Project.
-or-
From Word's RoboHELP menu, select Open File From Project.
The Open File From Project dialog appears.

2 In Files of type, select Project File (*.hpj). The HPJ file for the current project appears in File name.

3 In File name, select the HPJ file name and click Open. RoboHELP opens the HPJ file in Windows Notepad.

4 Edit the CNT= line, so it reflects the appropriate CNT file.

5 Save the HPJ file and exit Windows Notepad.

Note: If you prefer, you can open the HPJ file in another text editor (like Microsoft Word). Just make sure to 
save the file before exiting the editor.



Web Site output starts on a blank screen
If you view the Web Site output and your Internet Browser opens to a blank screen, check the CNT file. This 
usually occurs when the CNT file is empty in the source Help project. (In other words, there are no entries in the 
TOC for the source Help file.) 

Try the following:

· Remove or rename the CNT file using Windows Explorer, then generate the Web Site again using RoboHELP’s 
Single Source.

· Create a TOC for the source Help file, then generate the Web Site again using Single Source.



Internet macro doesn't open from an HTML conversion
If your source Help file contains an Inet macro on a page in the Help project’s CNT file, check the macro syntax. 
Make sure the entire URL address is in the macro. You need to include the "http://" part of the address, as well. 
(For example: http://www.blue-sky.com)

Edit the Inet macro, as needed, then generate your Single Source HTML output again. 



RoboHELP opens in the wrong version of Word
This problem usually means you have both Word 95 and Word 97 installed on your system. Windows chooses 
which version of Word to open based on what is listed in the Windows Explorer View menu, Options, File Types. 
You may need to edit the paths of the functions here – New, Open, and Edit – so they reflect the location of the 
version of Microsoft Word you want to use. 



Slow response time for RoboHELP
If you’re experiencing slow response time from RoboHELP (or Word) – especially when saving, try the following to 
the optimize both your system and Microsoft Word: 

Switch your image view mode from Dynamic WYSIWYG to True Code. Dynamic WYSIWYG requires more PC 
resources because the images display in the Help document just as they will in the compiled Help file. 

1 Open a Help document in the Help project. From Word's RoboHELP menu, select Dynamic WYSIWYG 
/TrueCode. Under View Mode, select Convert to True Code. 

2 Repeat this procedure for every Help document in the project until all images have been switched to True 
Code.

Make sure the disk where Windows is installed has at least 10% total available disk space free. Most 
systems configure virtual memory to take a certain percentage of available disk space. An industry rule-of-thumb is 
that running with less than approximately 10% total disk space free (64K is recommended) impacts the speed of 
all applications on your system, including RoboHELP and Microsoft Word. (Word can create large temporary files.)

1 Check the amount of free disk space. (64K or more is recommended.)

2 If less than the recommended 10% of the available disk space is free, increase the amount of available disk 
space. Often, removing temporary files or emptying the Windows Recycle Bin frees significant disk space. 
(Consult your network administrator, PC technician, or operating system’s Help or documentation for further 
assistance.)

Disable "Auto Start Word" in the RoboHELP Explorer. If you don’t want Microsoft Word to launch every time 
you start RoboHELP, clear this option. RoboHELP Explorer loads your project more quickly, and Microsoft Word is 
launched when needed to perform editing.

1 From RoboHELP Explorer's Tools menu, select Options, and then select General.

2 Clear the Auto Start Word option.

Disable Microsoft Word Save options. The features on the Microsoft Word Save tab (Tools menu, Options) are 
known to cause performance problems when saving large documents. Disable these options and remember to 
manually save often.



Topic does not exist (129)
You might receive this error for several reasons:

· The Topic ID does not exist. Check the Broken Links folder to resolve any broken links or create a new topic 
with the appropriate Topic ID.

· The Map number being called by the application has no associated Topic ID (context-sensitive help). Find the 
Map ID and make sure it’s attached to the appropriate Topic ID. If not, create an Alias.

· The topic being called by the Contents tab is part of an included CNT file and is specified to display in a 
particular window. The included CNT file does not include the external Help filename. A limitation in the WinHelp 
viewer causes the "Topic does not exit" message to appear when the user selects a topic (page) specifying a 
window from the external CNT file without the "@helpfilename.hlp" statement. 

To workaround this WinHelp viewer limitation, you can either manually insert the Help filename statement on every 
page of the external CNT file or allow RoboHELP to automatically do it for you: 

1 Open the Help file containing the included external CNT file. 

2 From RoboHELP Explorer’s File menu, select Project Settings. 

3 Select the Contents tab. 

4 Select the Include Help filename with pages option. When you save the TOC file, this option automatically 
places the "@helpfilename.hlp" inside the CNT file on every page.

5 Click OK. 

6 Save the external CNT file. 

7 Recompile the Help project.



Transparent bitmaps don't display correctly
At times a transparent bitmap may not appear correctly. If this is the case, it may be related to a Windows 
95/Windows NT Help bug. Try one of the fixes listed below if you have difficulties with a transparent bitmap:

· Sometimes this problem occurs when you have a non-scrolling region color that is different from a scrolling 
region color. To correct this error, simply select the same color for both the non-scrolling and scrolling regions.

· This problem also may occur when you attempt to place a transparent bitmap in a window with a dithered color 
as background. Try changing the background color to a solid color.

Tip:

For more information about transparent bitmaps and working with images, from the RoboHELP Help file look in 
the Images book (under the Using RoboHELP book).



Help file corrupt error
Sometimes this message appears after you compile the Help project and select Run. If the file is not corrupt, the 
fix listed below usually corrects the problem.

· Delete the hidden GID file for the Help project. If you have more than one copy of the Help project on your 
machine, make sure you delete the GID file in all locations. Try recompiling the Help project and running it 
again.



WYSIWYG images don't display correctly
If you add an image (or button) in Dynamic WYSIWYG mode and the image doesn’t appear correctly, it may be 
because Word’s View Field Codes option is selected. 

For example, if something like the following code appears { EMBED RHGRAPH.DOCUMENT /s} instead of the 
image..

To turn off the View Field Codes option:

1 Open the Help document.

2 From Word's Tools menu, click Options.

3 Select the View tab.

4 Clear Field Codes.

5 Click OK to save and exit.

Tips:

· Another possibility could be that your PC has run out of memory. Try switching from Dynamic WYSIWYG to 
True Code and then back again.

· Try shutting down other open applications. Or try exiting RoboHELP and shutting down your system 
completely to clear the machine’s memory of any "extra" programs.



General troubleshooting
Here are some guidelines to help you troubleshoot problems:

· Use this Troubleshooting section. This section provides information and solutions to help you troubleshoot 
some of the common conditions you might need to troubleshoot in your Help project.

· Use the online Help. Try looking up the problem in the Help index under the problem's related area. For 
example, if you can't delete a window because it's referenced in the project, look under Windows for a 
Troubleshooting entry.

· Use the Error Wizard. This handy RoboHELP tool provides explanations for compiler messages and possible 
solutions for resolving problems. It can also help you locate several error conditions in the Help project.

· Use RoboHELP reports. RoboHELP provides a bonanza of reports that put information about your Help project 
at your fingertips. Most reports are customizable, so you can find just what you're looking for.

· Use the Diagnostics Report. This report is specifically designed to help you pinpoint potential errors or 
problems in the Help project. Customize the report using the Diagnostic Report Options dialog.

· Use eHelp  ’  s Knowledge Base  . If you have access to the Internet, you have almost instant access to our 
Knowledge Base, which contains answers to frequently asked questions and troubleshooting solutions.

If all else fails …

If you still can't locate the information you need to help you resolve the problem:

1 Document what you were doing and what happened – what problem are you experiencing? What steps have 
you already taken to locate or resolve the error?

2 Contact eHelp Corporation Technical Support.



Cannot find or load the file (DLL) or Routine not found
When viewing the compiled Help file, if you get the message "Cannot find or load the file filename.dll" or the 
"Routine not found" error message, this means a DLL needed by the compiled Help file can't be located on your 
system. DLLs should always be located in the user's \System directory under the operating system folder. (For 
example, \Windows\System or \Winnt\System32.) 

To locate missing DLLs:

1 From Windows Explorer's Tools menu, select Find > Files or Folders. The Find: All Files dialog appears.

2 In Named, enter the name of the missing DLL.

3 In Look in, select or browse to the drive containing your operating system.

4 Select Include subfolders for the best search results.

5 Click Find Now to initiate the search.

6 Review the search results:

· If the DLL lists in the search results, make sure it appears in your \System folder. If it doesn't, use Windows 
Explorer to copy the DLL to the appropriate \Systems folder.

· If the DLL doesn't list in the search results, try searching the drive where you installed RoboHELP. If the DLL 
still can't be located on your machine, try reinstalling RoboHELP. If the DLL is missing from a user's 
machine, you can send the missing DLL to the user. Make sure to instruct the user to place the missing DLL 
in the appropriate \System folder.

(Close the Find: All Files dialog when you're finished.)

You can use RoboHELP's Diagnostics Report to check for missing DLLs before you compile. 

To generate the Diagnostics Report:

1 From RoboHELP Explorer's Tools menu, select Reports > Diagnostics Report. The Diagnostics Report 
dialog appears and RoboHELP generates the report.

2 Make sure the Check for missing DLLs option is selected:

· Click Options to open the Diagnostics Report Options dialog.

· Under Missing Files, make sure Check for missing DLLs is selected.

· Click OK to close the dialog and regenerate the Diagnostics Report.

3 If a DLL is missing, use the instructions above to locate it. 
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